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1. Introduce 

This is common information publishing software, it can help you easily edit and distribute media 

to all types of display devices. It will manage several devices with the same interface, which will 

help user edit and playback the media information easily. This system also supports network 

operation, automatic scheduling, shortcuts control, and external control interface, etc. 

 

1.1 System Architecture 

This system is composed by two parts, “editor” and “player”. All the device management and the 

media editing functions are on the “editor” module, the “player” is unattended. The “player” 

could be installed on multi-computer in the LAN, then connect the display device through video 

port or serial ports. End users can manage all these devices through the “editor” in the LAN. 

 

System architecture as shown below: 

 
 

 

 

 

 

1.2 Glossary 

The media information in this system is organized by “Script”, and its hierarchy: 

Script—> Device—> Program—> Window—> Play Item 

 

 

In the standalone edition, the “editor” and “player” are running on the same 

computer, and all controls to the “display” are automatic. 
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（1） Script: As a file, it’s a document which defined the devices and the media information. 

The schedule task, and other functions are based on the script file. 

（2） Device: It defined through “Device Configuration” dialog. You could define difference 

kinds of media content for each device, and they will also be played on different physical 

devices through the “player” module. 

（3） Program: The definition of the layout of the windows in one device. Some devices could 

separate the whole view rectangle into several windows, so with the different layout 

definition, there could be several program for one device. These programs will be 

playback one by one. 

（4） Window: Define a media playback area on the device. It belongs to the “program”. All 

play items belong to this window will be shown in this area on the physical device. 

（5） Play Item: Definition the media item in the window, which could be all kinds of video, 

image and text files. It could also be a database view or the clock. 

Script 

Device 

Program 

Window 

Play Item 
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2. Editor 

Open the “Editor” and the main interface as follows: 

 

 

2.1 Device Configuration 

After the system is installed, the first thing to do is to change the configuration of devices. Choice 

menu “Tools”->“Device Configuration”, the following dialog will be shown: 

 

 

Left side is the list of all machines (player module) and devices. You could use the “New Machine” 

http://www.kazovision.com/
mailto:sales@kazovision.com


 

Kazo Vision 

WEB: http://www.kazovision.com  MAIL: sales@kazovision.com 

5 

button to add a new machine. Use the “New Device” button to add a new device into the 

selected machine.  

In right side, you can set the “Name” and “Address” for the machine. The “Address” is the IP 

address of the machine, system will communicate with the device through this IP address.  

 

 

 

 

You can define the device caption in the “Caption” textbox, and set the device ID in the “Unique 

ID” textbox. 

 

Select the “General” tab, there will be shown the info as follows: 

 

 

Playback window show on monitor: when you use several monitors on one computer, you can 

select which one should the playback window be shown. 

Playback window stay on top: the window will stay on top of the desktop when displaying 

contents. 

Hide screen cursor: check this option will hide the screen cursor when displaying. 

Hide background window: when playback the media files, there will be only shown the actual 

playback window on the device, and the background window will be hidden. 

 

The system supports all types of display devices. You could add different devices to the selected 

machine according the actual conditions. Against the video device (LCD, PDP, Projector and 

Synchronous LED), you only need to set up the display window’s regional; against the 

asynchronous LED device, you need to set up the communications parameter, such as serial port, 

 

In the standalone system, you could only use one machine (the Local Machine). 

So you needn’t set this “Address”. 
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and so on. 

 

The system also supports the Power Management for the device. You just need set up the 

communicate parameters for power control device. So it will be easy to control the power and 

enable devices through the software remotely. 

 

 

 

 

 

 

When complete the configuration of devices, press “OK” button to return the main interface. The 

software will apply the new configuration immediately.  

 

2.2 Editing media information  

The left side of the main interface is “program” and “window” tree. You can view and select all 

devices from it, as well as the program or a window. 

 

 

 

The Power Management depends on the power controller produced by our 

company. You can contact us for the detail of it. 
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Press the “ ” button could append a new program to the device. When selected a particular 

program, press the “ ” button to delete it. At the same time, you can press the “ ” or “ ” 

button to change the sequence of program. 

 

The top side of the main interface is the “window” select area. You can see the visualization 

“Window” of the current “Program”. And adjust the window’s size directly. 

 
 

Press the “ ” button to add a new window to the current program. You can select and move the 

window directly, or adjust its size by drag the small rectangle around the window. 

 

At the right side of the main interface, you can modify the parameters of the selected “Program” 

and “Window”. 

After selected a “Program”, click the “Details” button will open the “Program Properties” dialog: 

 

 

The “Program” has two types of play method: indicate the repeat times or the play time. It will 
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flip to the next program automatically when the specified repeat times or the play time reached. 

 

When there are several “Windows” in the program, the program will not increase the repeat 

count until all “Windows” have finished display. So for some cases, the “Window” with less 

information will loop itself automatically. 

 

You also could set a period to play, such as 9 a.m to 5 p.m on workdays in December, 2012. 

 

Each “Programs” will be played one by one as its defined sequence. When there are only one 

“Program” be defined, the contents in this “Program” will be looped automatically, until the user 

stop displaying current “Script”. 

 

After selected the “Window”, the bottom side of main interface will list all “Play Items” belong to 

this window, as shown below: 

 

 

You could press the “ ” or “ ” button to add the different format items into current window. 

Now the system could support many formats, they are: video file, video signal, flash, image file, 

image list, text file, and text, excel file, power point file, database, clock, timer and website. 

 

Press the “ ” button and choose the “Video File”, there will be shown the dialog as follow: 

 

(01) Video File 
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Click the  icon to add a video file, the caption text will be the same as the file name, and you 

can modify it.  

And it’s a drop-down list mark beside of the icon, there are another two function to select. 

 

 

“Edit File”: It’ll open the video file with the video editor of your system. 

“Show In Folder”: It’ll show you the file in which folder.  

 

Checkbox “Overlay Text”, enable this function, it will overlay a text on the video. 

Input text in the blank, click “Modify Font” pops up a dialog box to modify font, and you can also 

select the align type and move type. 

 

(02) Video Stream 

It is used to broadcast the tv live or any other live. 

Before using, you need to build a stream media server and relevant hardwares, such as the video 

capture card, the tv set-top box, etc… 
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Caption: The title of the video stream.  

URL: Input the IP address and port number of your stream media server. 

Stay Time: Duration of the media displays.  

 

(03) Video Signal 

It’s also used to broadcast the tv live.  

You should equip each player terminal with the video signal source, the tv set-top box, the video 

capture card.  

 
 

Video Source: To select the type, it must be matched with the enabled video capture card port. 

Type for select: Tuner, Composite and S-video, click the drop-down list to select. 

 

(04) Flash File 
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Add the flash file you need and select the layout in the “Layout” dropdown list and press the “OK” 

button 

 

(05) Image File 

 

 

Entry/Exit Effect: The effect of the images entrance and leave. Such as fade in, fly in from top, 

etc… for select. 

Speed: Two scroll bars to adjust the entry and exit speed.  

 

 

(06) Image List 
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If you want to add several image files at one time, you could add all files’ pathname together in 

one list file. So you will avoid adding the new image file again and again. Press the “View file 

format of Image List”, then you will see the sample of the image list file: 

 

 

(07) Text File 
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File Name: You can add files as “RTF”, “DOC”, “TXT” format. 

Font: Modify the font, size and color of the text. 

Background: You can select a pure color as the background. 

 

(08) Text 
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Instead of add text through a text file, you also could input the text in the software directly. The 

text here could be set to different font or colors. 

 

(09) Pixel Text 
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Perform the text with pixel, you can set the pixel size,color and zoom, the other is similar to (08) 

Text. 

 

(10) RSS Text 

 

 

Load a URL of RSS directly to display the text. 
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(11) Excel File 

 

 

You can add an excel file, and choose any sheet to display. 

 

(12) Csv File 

 

 

Add a csv file, and set the play form to display it aesthetically. 
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(13) PowerPoint File 

 
 

Add a PowerPoint file to display, and you can modify the flip delay. 

 

(14) Database 

This function could help you display data from different of database engines. So the software 

could be used to display the real time data from database. 

 

 

After the database connection string be set, all available tables of current database will be shown 

in the “Query SQL” dropdown list. You can choose the table you want to display from it, or just 

http://www.kazovision.com/
mailto:sales@kazovision.com


 

Kazo Vision 

WEB: http://www.kazovision.com  MAIL: sales@kazovision.com 

18 

input the query SQL here. You can use any standard SQL queries in the software, to filter out the 

data you want. 

When you finished the query SQL, all available fields will be listed in the “columns” list. You can 

select each field, and set its display caption or the column width. 

 

 

Select one field and press the “Advanced” button will appear a “Database Field” dialog. You can 

set the visual effect for each field, as well as let the software do some data conversion through 

this dialog. 
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(15) Web Site 

 

Input the web site, then click the OK. It will embed a browser in the window and display the 

website.  
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(16) Clock 

 

 

Embed a simulation clock to display the time info. 

There are two kinds of clock type in this system, one is “Text”, and the other is “LED”. 

 

(17) Timer 
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You can use this program in the case which need count down time. 

 

(18) Sensor 

 

 

Configure the content, it will receive the data from the sensor automatically. 

 

(19) Weather 
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Server: The website to provide the weather information.  

We provide you a default server.  http://weather.kazovision.com 

You can input the city and region, then check it in advance.  

 

(20) Program 
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Choose an executable file, and input the necessary parameter. 

 

If you want to modify the created play item, you can select it and press the “ ” button, or right 

click the item and select “Modify Item” option. This will open the item edit dialog for modify.. 

 

And there are other buttons above the item list, they are “ ”, “ ”, “ ”, and their meaning is 

delete, move the item up and down.  

 

2.3 Save and Playback the Script 

After edit a script, you could click the “ ” button to save the script to a file. The script file could 

be read back easily. 

 

After opened a script file, press the “ ” button to play all contents defined in the script. All 

“player” will start playback automatically.  

 

 

 

 

2.4 Play and Stop 

After open a script in the “editor”, press the “ ” button to publish the contents to the “players”. 

Beside the normal play functions, you also could publish temporary information on the screen. 

The temporary information will be covered on the normal media screen. You can press the “Play 

(Temporary Notify)” and “Stop (Temporary Notify)” item in the “Control” menu to use this 

function. 

 

The temporary info is also a script; the creation of the temporary info is as same as the normal 

script. It’s different only when you select a different publish type. 

For example, if you have create two scripts A and B. The A was published with normal play 

method, and B was published with “Play (Temporary Notify)”. You will see the contents of B be 

overlaying on the A. 

 

2.5 Schedule Task 

You can set the schedule task in this system, and the schedule item will automatically start to play 

a script or open the power at specified time. 

Select “Tools” —> “Schedule” in the menu, following dialog will appear: 

 

In network edition, you should make sure all clients opened the “player” 

program before start play. 
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Press the “New Item” and appear the “Schedule Item” dialog: 

 

 

There are several schedule types for the automatic scheduling item: Indicated time, every day, 

every week, or every month. 

 

The type of schedule item includes: Play, Stop, Play (Temporary Notify), Stop (Temporary Notify), 

Power On, and Power Off. 

When you select the “Play” or “Play (Temporary Notify)” for the type, you will also need to select 

a script file for use. 

 

The system could become an automatic playback system through the scheduling function. 
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2.6 Statistics of Display 

Select the “Tools”-> “Statistics”, and appear the following dialog: 

 

 

You can set the statistics method and the filter, select the device and caption that you need. Then 

press the “Update” button to get all statistics information which meet the filter condition. 

 

Press the “Export” button to save the information into the local PC. 

 

 

 

 

 

2.7 LED Screen 

This module could import the LED parameters into our system automatically, and then you can 

use our software to display multimedia information on your LED screen without any 

configuration. 

 

Press the “LED Screen” menu: 

 

 

 

You should make sure the “editor” has been opened during use the schedule 

function, and it could communicate with the “player”. 

 

You have to ensure all players have been opened before using the statistics 

function. 
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The software will list all detected LED systems. You can select the system type and import its 

settings: 

 

 

The software will detect the current LED system automatically; you should choose the one that 

you are using. And press the “Import” to import the specified LED parameters into software. 

 

If you check “LED Screen Test”, it will show a LED test software, which will help you adjust and 

test the LED screen. 

 

 

2.8 Special function of the Program 

2.8.1 Program Dispatch 
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You can equip the hardware device according to our software protocol and press the “Option” 

button on the “player”. Then you can see the “Comm Control” and “Network Control” options, 

set the parameter for the method you will use. After that, you could use the external device to 

dispatch the program. 

 

 

2.8.2 Advanced Function 

Select one item and right click, choose the “Advanced Function” option: 

 

 

This function is for the case that information needs to update regularly. You can make a program 

which will update the contents that used to be display. The player will run this program each time 

before it going to display the contents. So you can make this contents be refreshed itself. 

 

Check the “Run program before show this item” and add the pathname of executable file to 

“Program” textbox to use this function. 

 

2.10.3 File Transfer Rule 

Right click one item and select the “File Transfer Rule” on the pop-up list: 
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If you check the “Use local file for playback” on the dialog, you should ensure the item you want 

to play has been copied to the same path on the player. 

 

2.8.4 Group Edit Mode 

Press the “ ” button could edit the contents for all devices in the same time, so if several 

devices will play the same contents, you only need to edit it once. You could abstract many 

devices which have similar size, and then edit program on this device. 

 

 

 

 

The program editing, windows adding and items adding are the same with commonly mode.

 
This function will not take effect if there is only one device be defined. 
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3. Player 

“Player” is the software which will communicate with display device. Generally, what you need to 

do is just open the “player” program on each computer, and set the system’s firewall to allow it 

communicate through network. The “editor” will communicate with all “players” through 

automatically when you start playback the script. 

 

 

Click “Options” button will open the options dialog:  

 

 

You can set if the “player” needs to be startup with the system automatically here, and the temp 

file’s path, etc. 
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4. Supported Media Formats 

Media 

Type 

File Formats Notice 

Video AVI, MPEG, MOV, WMV, 

ASF, MKV 

Some video formats are not supported by the new installed 

Windows System. You should also install the codec for it. 

There is some codec pack link you may install to get all 

favorite codec. 

Windows XP: XPCodec (http://www.xpcodecpack.com/) 

Windows Vista: VistaCodec 

Windows 7: Shark007’s FREE Codec: 

(http://www.shark007.net/) 

Video 

Stream 

MMS MMS video stream can be provided by Microsoft Media 

Encoder. 

Video 

Signal 

 Compatible with all video capture devices, include USB Cam. 

Flash SWF Need the flash player component. 

 (http://get.adobe.com/flashplayer/) 

Notice: Do not support FLV format, but you can create an 

html file which embed the FLV file, and play it with WEB Site 

method. 

Animation GIF  

Image BMP, JPG, PNG,TIF  

Format 

Text 

DOC, RTF You need to install the “Microsoft Office” to support the DOC 

file. 

Plain Text TXT  

Excel XLS You need to install the “Microsoft Office” to support the XLS 

file. 

Power 

Point 

PPT You need to install the “Microsoft Office” to support the PPT 

file. 

Notice: Just install the “PowerPoint Viewer” is not enough. 

Database MDB (Access), SQL 

Server, Oracle, DB2, 

MySQL, PostgreSQL 

We use the ADO database interface, to support all kinds of 

database. 

You should install the Database Driver or Client Application. 

Web Site  Use the Trident (IE) engine to display the web content. 

Program EXE Run the third party executable file. 
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